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1. Introduction 
 
 

1.1. Project History 
 
The idea of making a 1/10 scale dynamometer car was suggested to me by John Lyas in 1994.  
John had sourced information on a South Australian Railways prototype, and I addressed the 
problem on how to do the instrumentation.  The instrumentation system was first fitted 
temporarily fitted to my 5”g passenger truck, so that we could run the system at the 1996 
Australian Convention of model engineers, being held in Adelaide. Soon after, John completed 
the coachwork and subframe, and I made temporary 3-piece bogies.   Later John made proper 
passenger type bogie frames, using the wheelsets from the original bogies (which subsequently 
finished up on my one of my riding trucks). 
 
I wrote the first version of this document during a business trip to Sweden in March 1996: the 
only “spare” time I could find.   Its purpose was purely as a record for John and me, but it was 
probably downloaded from my website many times by interested people all over the world.  This 
version was written in May 2009 to update the information, as a number of changes have been 
made over the years. 
 

1.2. Overview of Railway Dynamometry 
 
Railway engineers have always been concerned to get the maximum work out of their 
locomotives for a minimum consumption of fuel.  An important part of railway  engineering has 
been to experimentally measure the work done by an engine so that an objective measurement 
of efficiency can be obtained.    
 
Collecting real data in this way lets the engineer compare locomotives (and their crews) and 
make better decisions regarding locomotive design, operation and management. 
 
The purpose of a dynamometer car is to measure the output of a locomotive at the drawbar 
while the engine is in real service.   This is in contrast to fixed dynamometer installations where 
the locomotive is mounted on a laboratory test bed and real driving conditions must be 
simulated.  
 
The primary quantities measured are the drawbar pull (called “force” in this document), and the 
speed of travel.  Knowing the maximum drawbar pull is of some immediate interest because this 
determines the weight of the train that the engine is capable of pulling.   Also, the instantaneous 
power output can be derived from these primary measurements, because Power = Force * 
Speed. 
 
However, the more fundamental quantity desired is the work done over a given run, because 
this can be divided by the energy content of the fuel consumed, and produce an energy 
conversion efficiency for the locomotive operating under those conditions.  Work done is 
measured in units of energy, and is calculated by integrating (“adding up”) the instantaneous 
power readings.   For example, if the power is measured at fixed time intervals, then the energy 
output is 
 
Energy = Sum of (Power * TimeInterval) 
 
calculated over the entire time of the run. 
 
This is not the only way to calculate the work done.  Traditional dynamometer cars used a 
moving paper chart to record force and speed, but the chart paper was advanced by connecting 
the drive to the wheels of the car.  Pens moving laterally across the paper plotted the force and 
speed, driven by mechanical instrumentation.  In other words, the chart movement was distance 
based, not time based.   This meant that the engineers could use graphical techniques to 
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measure the area under the force curve, which is an alternative method of calculating the 
energy output. i.e. 
 
Energy = Sum of (Force * DistanceStep) = (Area under the Force vs Distance curve) 
 
calculated over the entire distance of the run. 
 
In this scale model dynamometer car, we have adopted the same distance-based scheme 
because it is more meaningful to view a graph of force versus distance.  This is particularly so 
when the train may be stopping during the run: when the train stops, the data logging stops, 
which avoids the need to store unnecessary data. 
 
To summarise, the dynamometer car logs the force and speed versus distance travelled, and 
from that information the power levels and work done can be determined.   Secondary statistics 
which can be obtained are quantities such as maximum force, power and speed, and if 
additional fuel measurements are made then overall thermal efficiency can be found. 
 

1.3. Units of measurement 
 
Traditional locomotive engineers usually calculated in Imperial units.  The software for this 
dynamometer car is written with standard metric (SI) units.  The following table compares the 
units used in both systems 
 
Quantity SI metric unit Imperial unit Conversion 
Force Newtons Pounds Force 1 lbf = 4.5 N 
Distance Metres Feet  1 ft = 0.305 m 
Energy (or Work) Joules ft lb  1 ft lb = 1.37 J 
Speed Metres/Second Miles per hour 1 mph = 0.45 m/s 
Power Watts  Horsepower  1 hp = 746 W 
 
In the metric system: 
Joules = Newtons * Metres 
(work = force * distance) 
 
Watts = Joules/Second = Newtons * Metres / Second 
(power = work/time = force * speed) 
 
In Imperial units: 
ft lb = feet * pounds 
(work = force * distance) 
 
Horsepower = 550 ft-lb/sec = lb * mph * 5280/3600 
(power = work/time = force * speed) 
 
Note that the consistent SI metric system requires no conversion factors.  Consequently 
calculation is simpler and less prone to error.   
 
In the more recent software versions, I have converted the displayed velocity units from m/s to 
kph, as most people find this more meaningful. Furthermore, the calibration force can be input in 
kgf rather than Newtons, since the reference spring balances used for calibration are in kg. 
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2. Data Collection System 
 

2.1. Overview 
 
The data collection system comprises: 
 
1. Electronic sensors mounted on the car to measure force, speed and distance. 

 
2. An electronic system to interface the sensors to a computer.  This system amplifies 

the signals, performs analog to digital conversion, and communicates with the 
laptop computer. 
 

3. A laptop computer, to interrogate the electronics system, read and convert the 
measured quantities, display the results, store the data, retrieve and print stored 
data, and manage the sensor calibration. 
 

4. Software custom written for the laptop computer. 
 

5. A power supply system, consisting of a car battery and an inverter. 
 
The car is set up by connecting the above modules and turning on the computer.  A menu 
based program lets the user test and calibrate the sensors, start and stop recording, and store 
or retrieve data.    
 
The car is placed directly behind the engine or tender at the head of the train so that it records 
the force at the drawbar.  While the train running, the computer screen displays a mimic of a 
scrolling paper chart.  At the end of the run, the data is stored on disk. 
 
At any time, the data can be retrieved and displayed on screen, or printed out. 
 
In 2005 an external load cell was made, and it can be used as an alternative to the internal load 
cell.  The external load cell substitutes for a connecting link approximately 150mm long, with 
6.5mm holes for pins. It is normally installed behind the tender of the locomotive under test, so 
that the driver can choose to use their normal driving truck and have their mass included in the 
train.  This is fair for smaller engines (3.5”g and 5”g), but most 7.25”g engines are driven from 
the tender and the driver’s mass is unavoidably included with the locomotive and not the train.  
The external load cell is on a long flying lead, so the dynamometer car can be placed anywhere 
in the train. 
 
  
 

2.2. The Energy-based Logging Method 
 
Instead of drawing a graph on a paper chart, the computer stores numbers and plots graphs on 
the screen.    In this model, numbers are recorded every 32 turns of the wheels, which is about 
7.5 metres.  We call this a section. 
 
Thus for every section of approximately 7.5 metres, the computer program needs to store a 
force and a speed.   However, there is a complication.  While the locomotive is traversing any 
section, the force and speed will vary.  Unfortunately, it is invalid to simply log the average force 
and speed.   
 
To illustrate this, imagine that the train is starting from rest.  The force could be highest when 
the speed is lowest, and when the train is moving, the locomotive could be coasting with zero 
force.  In this case, the true energy output from the locomotive will be much less than the energy 
that would be calculated from AverageSpeed * AverageForce, and the dynamometer car would 
be overestimating the true work output. 
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This problem is overcome by calculating the work done three times per second, instead of just 
once per section.  A running sum of the work done is maintained until the section is complete.  
This could take only a few seconds at full speed, or thousands of seconds if the train stops 
within the section.  However, we are now making the much better assumption that the force and 
speed are approximately constant for 333 milliseconds, rather than for a whole section.  This 
gives us a very accurate measure of true work done. 
 
Because the program calculates the section work done with such good precision, it makes 
sense to store this value instead of force.  After all, the main quantity of interest in dynamometry 
is the work output, not the force or the speed.  The program also stores the time taken to 
complete the section. 
 
Thus the computer really stores work done (joules) and time taken (seconds) for every section, 
rather than the force and speed.   
 
However, we wish to display the equivalent of a paper chart showing force and speed, just like 
the old dynamometer cars.  To do this, the program can work backwards from the stored section 
work done and section time taken.  The number of completed sections is known from the 
number of values that have been stored, so the total distance information is available. 
 
To calculate the effective mean force, speed and power of a section for plotting purposes, the 
program does this: 
 
AverageSectionSpeed = SectionLength / SectionTime 
(metres per second = metres / seconds) 
 
AverageSectionForce = SectionWorkDone / SectionLength 
(Newtons = Joules / metres) 
 
AverageSectionPower = SectionWorkDone / SectionTime 
(Watts = Joules / seconds) 
 
This may sound a little convoluted, but it results in a precise measurement of work done under 
all conditions, whether the train is accelerating, braking, stopped or even reversing!   Such a 
technique is more practical for model engineering, where it is inconvenient and perhaps unsafe 
to try to maintain constant running conditions on the club track. 
 
 It is important to recognise that the average section speed, force and power are derived values 
which relate to the true work done rather than to the simple (and misleading) time-averaged 
quantities. 
 

2.3. Working in Reverse 
 
It has been described how the program stores work output data every 7.5 metres after adding 
up the work done for every second of duration that the train takes to complete the section. 
 
It is assumed that the force and speed are constant over each sampling interval (1/3 second), 
so that the work done in that time interval is given by: 
 
WorkDone = Force * Speed * TimeInterval. 
 
By convention, Speed is positive when the train moves forward, and the Force is positive when 
the locomotive is pulling.  Thus the WorkDone will be positive. 
 
Should the engine push the train backwards, then both the Speed and the Force change sign.  
The two negatives cancel out and the WorkDone is again positive.  Hence the work output of 
the locomotive is correctly measured in both directions. 
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However, from experience with efficiency trials there is no need to cater for backwards running, 
and the software has been set up to zero any negative velocity.  This is called “Positive-only 
mode” and it can be turned off by the user if desired.  The Positive-only mode also zeroes any 
negative drawbar force, so if the locomotive is used for braking the train, the work done tally is 
not debited with work done by the train on the locomotive. 
 

2.4. Effects of Braking 
 
Normally the locomotive does work on the train by pulling it forward.  Should the train push the 
engine while still running forwards, the force goes negative, and the WorkDone will also go 
negative (if Positive-only mode is off).  The train is now doing work on the engine, and the 
program is deducting from WorkDone in the current section.   
 
For normal coasting with the regulator shut, this deduction will be small, but (if Positive-only 
mode is off) it does unfairly penalise the measured output of the locomotive.  If the locomotive is 
used for braking, then the penalty may be severe and the true efficiency of the engine will be 
underestimated. 
 
However, if the train is braked, slowing the engine, then the engine’s kinetic energy is 
accounted for as positive WorkDone on the train, because the Force and Speed are still both 
either positive (forward motion) or negative (reverse motion). 
 
For better accuracy then, all braking should be done by the train, not the locomotive, whatever 
the direction of motion. 
 
 
 

2.5. Additional Statistics 
 
The discussion above on the energy-based logging method applies to the precise measurement 
of output work done.  It does, in fact, throw away actual maximum and minimum values of force, 
speed and power, which would be of some interest also.  The program therefore keeps these 
separately, updating them every 333 milliseconds as required. 
 

2.6. Specifications 
 
The design maximum force is 1000 N in either direction. 
 
The design maximum velocity is 18 kph or about 6 m/s. 
 
The capacity of the program storage is currently 2000 datapoints, corresponding to about 16 km 
of running.  This quite adequate for the usual 30 minute efficiency trial run, which will usually 
cover about 5 km.  
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3. Sensors and Calibration 
 
 

3.1. Force 
 
Force is measured by a strain gauged load cells.  The built-in internal load cell was originally 
used in electronic scales.  It has a force measurement range of 60 Newtons (6kgf), while the 
drawbar pull could be up to 1000 N.  A low-friction mechanical lever with a mechanical 
advantage of approximately 1/16 is used to reduce the drawbar pull to a level suitable for the 
load cell.  The external load cell is home-made from a piece of thin-wall brass tubing, with a 
strain gauge bridge and end fittings compatible with the common rolling stock clevises with ¼” 
pins. 
 
In both load cells, the drawbar is effectively solid. 
 

 

Figure 1 Internal load cell 

 

 

Figure 2 CAD model of the 16:1 lever pivot shaft used for internal load cell. Drawbar connects via a 
yoke with bearings to the small (eccentric) stubs, and the shaft mounts in bearings on the 

intermediate diameter.  Load cell is actuated from the projecting arm. 
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Figure 3 External load cell. Used as the draw link behind the engine tender. 

 
To eliminate the signal noise generated by vibrations and rough track conditions, the electronic 
signal is low pass filtered to a cutoff frequency of about 1 Hz.  This has the effect of averaging 
the force signal over the sampling period and produces very consistent results under all running 
conditions. 
 
The force is calibrated by applying a known force to the drawbar, from a standard weight or 
spring balance. 
 
To minimise errors due to mechanical friction in the internal linkage, the lever has been 
precision machined and uses ball bearings on all pivots.  The mechanical hysteresis is smaller 
than the resolution of the A/D converter, which is about 0.3 Newtons. 
 

3.2. Speed 
 
Speed is measured by a DC tacho generator, belt driven from a non-braked wheelset.  The 
generator used is an ERNI DC minimotor, producing about 4.3V at 20 kph.  In May 2009 it was 
discovered that the calibration factor varied by several % as a function of speed.  This was 
traced to the effect of the drive torque causing the belt to flex and creep.  The drive torque 
varies linearly with speed when the DC generator is loaded by a fixed resistor.    The effect was 
minimised by using a voltage follower op amp in the circuit to make the load resistance 
effectively infinite.  Its effect has been virtually eliminated by a feature in the software which 
auto-calibrates the tachometer during the run, using the wheel rotation counter for a reference.  
Most trial runs are done at an approximately consistent speed and the errors would be 
insignificant.  As with the load cell, the signal is low pass filtered to 1 Hz cutoff frequency. 
 
The speed can be calibrated by following a routine written into the software which calibrates it 
from a known distance travelled and a known time.  The distance is derived from the wheel 
revolution counter, and the time from the computer clock.  The calibrations are written to disk file 
(see later for management of calibration data). 
 
In addition to the calibration routine just mentioned, the tachometer is recalibrated continuously 
on the run. Note that the tachometer is technically redundant, because we can determine speed 
from the wheel rotation and the time.  The reason for using the tachometer in addition to the 
wheel sensor goes back to the original hardware adopted at the beginning of the project.  This 
hardware did not have the capacity to pass timing events back to the computer: the computer 
could only poll the hardware at 1 second intervals.  Thus it was impossible for the wheel rotation 
events to be detected accurately in time by the computer in order to work out the speed.  The 
tachometer was introduced to provide a continuously-available analog speed signal for the 
computer.  Obviously, if I were starting with today’s interfaces, the architecture would not use 
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the tachometer.  But it is worth noting that the tachometer allows one to detect reverse motion, 
whereas a simple encoder (without quadrature outputs) does not detect reverse rotation. 
 
The automatic calibration keeps two tallies of distance travelled, one from the tachometer, and 
one from the wheel sensor. The tallies run only during non-stop running above a prescribed 
minimum speed.  When a prescribed non-stop distance (e.g. 100 metres) is reached the 
tachometer gain is adjusted by the ratio of the two tallies, and the tallies are then restarted from 
zero.  In this way, even if the speed calibration is wrong, it is corrected accurately after 100 
metres.  This automatic tachometer calibration effectively maintains accuracy of the work-done 
tally. 
 
The resolution of the speed signal is approximately 0.006 m/s. 
 

3.3. Distance 
 
Distance is measured by an optical sensor which counts turns of the wheels. This signal used to 
tell the program when a section (defined as exactly 32 turns, or approximately 7.5 metres) has 
been completed.  It is calibrated by measuring the wheel diameter with a vernier caliper, and 
entering the value into the program. 
 

 

Figure 4 Belt-driven tachometer and optical axle rotation gap sensor (including 13 years of 
accumulated dirt) 

 

3.4. Time 
 
The time base is derived from the built-in clock on the laptop computer.  No calibration is 
required. 
 
In the early days, the standard MSDOS computer setup updated the system clock 18.2 times 
per second, which gave us a clock resolution of 55 milliseconds. I understand that this has been 
superceded, but whatever it is, the work done accuracy is related to the clock resolution as a 
proportion of the time taken to complete a section (7.5 m) so it is of no concern. 
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3.5. Calibration files 
 
A file named “DefaultCalibs.cal” is maintained in the same directory as the program.  The 
program reads this file when started, loading the calibration values into memory. If the user 
performs a recalibration the file can optionally updated.  Also, the tachometer calibration in 
memory will be updated by the automatic calibration.  This revised value can be stored to the 
default calibrations too, but it is hardly necessary because it will corrected during a run. 
 
When the dynamometer data is stored at the end of a run, the current calibrations are stored 
with the data, and if the data is loaded back into the program for review, the associated 
calibrations come with it, also for review.  An appropriate warning will pop up if non-default 
calibrations are left in memory when a new run is started. One can then open the Calibration 
screen and click “Reload Defaults”. 
 
The calibration data provides for two alternative load cells and it is most important to tell the 
program which load cell is in use.  This is done under the “Setup” menu item.  Added protection 
against getting this wrong is provided by a pop-up screen whenever the Run menu item is 
invoked.  It advises the operator which one has been selected, before new data is taken. 
 

3.6. Settings file 
 
Another file named “dyn.set” is used to record program options which are not calibrations. 
1. Comport (now redundant) 
2. Positive-only mode setting 
3. Chartwidth (i.e. distance displayed before the chart scrolls) 
 
The user may be prompted to overwrite this file after doing a calibration. 
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4. Electronic Hardware 
 

4.1. Power Supply 
 
A 12V lead-acid motor car battery is carried.  A 12VDC to 240VAC inverter (150W rating) is 
carried to provide mains power for the laptop computer, and to power the electronics module. 
An additional 12V gel cell (from a security system) is used by the electronics module, and this is 
recharged from the 240V supply.  The gel cell is redundant now, because the system can run 
from the 240V, however, it is retained to stabilize the DC supply and to make the system more 
robust against outages of the 240V. The laptop computer will also continue to operate from its 
internal battery if the 240V fails.  Historically, the 240V is fairly reliable, but on one occasion the 
exposed car battery leads were accidentally disturbed, and sometimes the inverter has shut 
down by its internal temperature sensor. 
 

4.2. Analog Interface 
 
Circuit diagrams are given in the appendix.  The board holds a number of relatively small 
circuits required to drive the sensors and return clean, filtered analog voltages of 0 to 10V to the 
computer interface. 
 

4.3. Digital Interface 
 
The original digital interface was a custom made board incorporating an 8 channel analog-to-
digital converter chip, addressed by a 6402 UART (Universal Asynchronous Receiver 
Transmitter), so that the computer could initiate a conversion on a particular channel by 
transmitting an 8 bit character from its RS232 COM port.   When the conversion was complete, 
the 8 bit converted number was placed in the UART, which sent it back to the computer via the 
same COM port. 
 
This has been superceded by a commercial USB (Universal Serial Bus) device.  It is a cigarette-
box-sized plastic enclosure with screw terminals for analog and digital inputs and outputs, plus a 
USB socket.  It is one of the ECONseries economy interfaces made by Data Translation, model 
DT9812-10V.  It was sourced from: 
Kevin Dowsey 0417 580 709,  
kdowsey@turnkey-solutions.com.au  
Total Turnkey Solutions 
Level 1, 420 Sydney Rd 
Coburg, VIC 3058 
Australia 
Tel: (61) 3 9350 7377 
Fax: (61) 3 9350 7310 
E-Mail: info@turnkey-solutions.com.au  
http://www.turnkey-solutions.com.au  
 

mailto:kdowsey@turnkey-solutions.com.au
mailto:info@turnkey-solutions.com.au
http://www.turnkey-solutions.com.au/
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Figure 5 Analog/Digital interface. Analog inputs on the left, USB cable on the right. 

 
 
It accepts analog inputs between -10 and +10V, and converts to 12 bit accuracy at up to 50 
kHz, which is well beyond the real requirements for this dynamometer car. As stated above, if I 
were starting again I would use the digital input capabilities, but I have not invested the time and 
effort to do this so the system retains the tachometer-based speed measurement and polled 
data acquisition of the original design. 
 
Only four of the channels are used, for speed, force, wheel revolutions and battery voltage.  The 
wheel revolution input is a bivalued analog voltage, since it derives from a digital counter-
divider.  The computer senses when 32 revolutions have occurred by a level transition in the 
voltage.  Two transitions cannot possibly occur in less than the sampling time, so counts will 
never be missed. 
 
 

5. Computer 
 
The original computer used (in 1996) was an IBM compatible laptop manufactured by Sharp, 
model PC6220.  It had a 12MHz Intel 80286 processor, a 20 megabyte hard disk, a VGA 
monochrome LCD display, and 1MB of RAM. The operating system was MSDOS version 4. 
 
Now any laptop running Microsoft Windows and fitted with USB can be used. I keep an old 
Toshiba machine for field use. 
 
 
  
 

6. Software 
 

6.1. Overview 
 
The original program was written using Turbo Pascal version 7.0 for DOS.   It has since been 
upgraded and rewritten in Borland Delphi (an object-based implementation of Pascal) version 4.  
This provides a Microsoft Windows interface, with the conventional menus, icons and controls. 
 
When the program starts it checks for the presence of the USB interface.  If it is not found, the 
user is told that inputs are simulated.  Raw data is generated by a random number generator, 
but otherwise the operation of the program is unaffected.  This is convenient for demonstration 
and training, and makes the program stand-alone on any computer.  Foreseeably, the hardware 
is not always plugged in when reviewing the data files and preparing reports. 
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The File menu is used to save and load data files, and also to copy the main graphical image to 
clipboard for pasting into reports. 
 
The View menu is a simple toggle, between the main graphical display, and a text-based 
summary of the run so far.  It can be pressed during data acquisition if desired, without 
interrupting the data stream. 
 
The Setup menu provides for calibration and testing of the sensors, as well as a toggle to select 
which load cell is in use. Note that each load cell has its own calibrations and whichever one is 
in use must be calibrated.  The calibrations of both are stored, and switched in depending on 
the selected load cell. 
 
The run/stop menu starts and stops data acquisition. You can stop acquisition, and restart with 
an option of clearing the log or not. 
 
The Efficiency menu is a simple calculator enabling you to input the quantity of fuel used, and its 
calorific value.  The program will calculate the thermal efficiency from the current work done 
tally.  Typically, this is used at the end of a trial when the coal consumption has been 
determined.  The values are stored with the rest of the data when it is Saved under the File 
menu. 
 
The About menu displays version and identifying information. 
 
The Help menu displays a text-based help file with the basic “how to” steps enumerated. 
 
 
 
 

6.2. Program Technique 
 

6.2.1. Time-based Sampling 
 
Approximately three times per per second, the computer reads the four sensor signals (force, 
speed, wheel pickup, battery voltage), converts the raw signals to SI units, and calculates, for 
the last sample’s worth of motion: 
 
Speed   (Direct, m/s) 
Force   (Direct, N) 
Time since last reading  (from system clock) 
Power level   (watts = speed * force) 
Distance travelled   (metres = Speed * TimeStep) 
Work Done   (joules = force * distance travelled) 
 
It then stores the following quantities: 
 
Maximum speed  (keeps the largest value found so far) 
Maximum force  (keeps the largest value found so far) 
Maximum power  (keeps the largest value found so far) 
Cumulative section time  (last value + TimeStep) 
Cumulative distance  (last value + distance travelled) 
Cumulative work done  (last value + Work Done) 
 
The stored values are updated every sample until the distance sensor signals that a section is 
complete, after 32 wheel turns. 
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6.2.2. End-of-section Processing 
 
When a section is completed, the cumulative values from the above list are added to the 
permanent record, and new accumulations are started. 
 
The only complication is that the end-of-section will occur within a sampling period, rather than 
neatly on the boundary between two measurement periods.  In other words, the last 1/3 second 
of running straddles the section boundary.  This is handled by splitting the work done in the 
sample between the two sections.  Of course, one can argue that splitting the last 1/3 second’s 
worth of work done is hardly warranted, and it could justifiably be dumped into either section 
with no error in the total work done.  The strategy originated when the sample period was limited 
by hardware to 1 second, when it was justified to obtain a more faithful plot of drawbar pull at 
high speed. 
 
The computer works out the split by comparing the cumulative distance with the known section 
distance.  The cumulative distance will generally slightly exceed the section length, because the 
end-of-section sensor switched some time in the last second.  The extra distance therefore 
belongs to the new section.   
 
Thus the cumulative distance and work done in the last sample can be apportioned between the 
last and the current sections.  The statistics for the finished section are completed, and the 
cumulative values for the new section are initialised with the values left over from the last 
sample. 
 

6.2.3. End-of-run processing 
 
At the end of the run, the data can be written out to a named file on disk.  The data comprises: 
 
1. Header information, such as a short description, date and time 
  
2. Calibration values used to convert sensor values. 
  
3. Run Statistics, such as maximum power, average speed etc 
  
4. List of logged section energies and transit times. 
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7. Routine Operation 
 

7.1. Acquiring data 
When the system has been set up and calibrated, routine operation is relatively simple. 
 

o Turn the power switch on (see the red light blinking). 
 

o Turn on the computer.  After bootup, start the program. 
 

o If desired, review the setup options on the SETUP menu, and verify the sensor 
signals using Setup/Test. 

 
o Prepare the train. 

 
o Select RUN when ready. 

 
o Preferably, monitor the data on the run to check that the system is operating 

(see below), but this is optional. 
 

o When the run is finished, stop recording. 
 

o If the coal consumption was measured, enter the mass under the Efficiency 
menu item. This will calculate the thermal efficiency, and the data will be stored. 

 
o Select FILE, then SAVE, entering a name when prompted. 

 
 

7.2. Reviewing data 
 To see data which has been previously stored: 
  

o Select FILE, then LOAD. Choose a file from the list. 
 

o Use the zoom and pan controls (top left of screen) as needed. 
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7.3. Monitoring on-the-run 
 
The system does not require intervention during the run unless there is a failure (e.g. flat 
battery).  I recommend covering the laptop computer keyboard and screen to protect it from 
water, dust, oil, cinders and bright sunlight. 
 

 

Figure 6 View of running screen 

 
The top panel of the running screen labelled “Sector values” is of little importance to the user: I 
used it for validating end-of-section processing and might turn it off one day. 
 
The Immediate Values are valuable for verifying the sensor signals on the run.  The battery 
voltage refers to the 12V gel cell, not the car battery, and one can detect when it is charging.  
Sometimes the locomotive driver might want to know speed or power, and the observer can 
easily call them out from this panel. 
 
The graphs mimic a scrolling paper chart, as in the prototype dynamometer car. The distance 
scale is automatic (unlike paper) and the entire run distance is plotted, gradually squeezing up 
until it exceeds a set distance of, say, 3 km (which you can set under Setup/Calibrate) and then 
it begins to scroll. Of course, the entire data record is kept, up to about 16 km (currently).  The 
vertical scales are automatic, adjusting to display maximum and minimum extremes.  The charts 
can be manually scaled and scrolled when the data is reviewed after the run. 
 
If one presses the View menu item, the display is toggled between the graphs and a summary 
screen.  This can be done at any time without interrupting data acquisition.  It may be useful for 
watching the speed calibration automatically adjust. 
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The Trip Summary panel provides the latest cumulative data of time, distance and work done, 
plus average speed, pull and power. 
 
In the status panel at the bottom of the screen one can see the status of the interface. “a/d fail” 
means that the USB interface is unplugged.  The load cell is indicated too (INTernal or 
EXTernal). This is important so that the appropriate calibration constants are in use. Finally, a 
line of text can be saved with any data file, and this is displayed (if present). 
 

7.4. Calibrating force 
 
This is best done under workshop conditions, with a suitable frame to provide a purchase point 
for a good spring balance, reacting against the car buffer beam.  It saves time to connect the 
two load cells in series, i.e. with the external load cell connected to the dyno car coupler.  I use 
a ratchet strap to adjust the applied force via the spring balance.  Since there is a low-pass filter 
on the force signal, one needs to keep the applied force steady to avoid a transient error. 
 
The program leads you through a two-point calibration procedure, entered via 
Setup/Calibration/Force.  This has to be repeated for each load cell, and it is important to have 
the correct one selected (under Setup) when doing its calibration. 
 
The final constants are presented to the user for acceptance before being placed into memory 
for use.  If accepted, one is also prompted to optionally record it to the default calibration file, so 
that it is available for adopting next time the program is started (or defaults are reloaded).  A 
further prompt may occur to enable one to rewrite the settings file too. I usually just click “yes”. 
 
Under Setup/Calibration one can manually edit the gain and offset constants if desired, but this 
is not normally required. 
 
 

7.5. Calibrating Speed 
 
The wheel diameter is used as the distance reference and it should be accurately measured 
and entered under Setup. It will be stored in the default calibration file and should rarely need 
updating. 
 
The speed calibration can be done either on the track, or in the workshop if one arranges for an 
electric motor to spin the instrumented wheelset at any selected constant speed.  Note that the 
automatic calibration routine is active at all times, and even if the calibration is out it is quickly 
corrected, transparently to the user.  (One can watch the slight calibration adjustments during a 
run, using the View menu item to toggle the display.)  However, it is preferable to start with 
correct values by following the two-point calibration procedure provided in the software under 
Setup/Calibration/Speed.   
 
As with the force, one should avoid transient error by establishing steady input values.  The first 
point is taken at zero speed.  The second point is taken while running at a moderate steady 
speed.  The software will delay the measurement until a section boundary is triggered, so that 
an accurate distance can be obtained.  Time is taken from the computer clock to calculate 
speed. 
 
The measurement takes place over one section, and the final constants are presented to the 
user for acceptance before being placed into memory for use.  If accepted, one is also prompted 
to optionally record it to the default calibration file, so that it is available for adopting next time 
the program is started (or defaults are reloaded).  A further prompt may occur to enable one to 
rewrite the settings file too. I usually just click “yes”. 
 
Under Setup/Calibration one can manually edit the gain and offset constants if desired, but this 
is not normally required. 
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7.6. Measuring coal consumed 
 
I consider that this is the most error-prone factor in measuring locomotive thermal efficiency.  
The reason is that one cannot be precise about reloading the firebox to the same fill state after 
the run.  Typical efficiency trial runs last for 30 minutes, and the mass of coal burned relative to 
the average mass of the bed on the grate will vary considerably depending on the size of the 
engine and its load. Where this ratio is small, the accuracy of the measurement will be small 
because of the uncertainty in the refill level.  It is particularly a problem with large engines 
running lightly loaded. 
 
The best approach I have been able to implement is to encourage drivers to make their engine 
work hard according to their capabilities, and then to appoint an experienced independent 
official to fill the firebox to the driver’s preferred depth before the run, and refill to the same level 
at the end.  This requires care and skill to achieve a similar degree of packing and levelling of 
the firebed each time. 
 
The coal is weighed with electronic scales and a system of buckets and paperwork set up, to 
maintain a consistent process and documentation. 
 

7.7. Results 
 
Using the Efficiency menu item enables one to produce a thermal efficiency figure almost 
immediately after the run, and it is interesting to watch the list develop and rankings change as 
a test day proceeds.   To date, results taken with this car have ranged from 0.1% to 2.1%, with 
most locomotives around 1%.   
 
The locomotive returning the highest result so far is pictured on the cover of this report. It is a 
5”g model of the British 4-6-0 Class 5MT, popularly known as “Black Five”. 
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8. Appendix  - Circuit Diagrams 
 

  
Figure 1/5 
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Figure 2/5 
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Figure 3/5 
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Figure 4/5 
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Figure 5/5 
 


